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1 Imprint 

 

Copyright: 

This manual is copyrighted. The author is Opto France. 
All rights reserved.  
In particular, any reproduction, editing, distribution (making available to third parties), translation or 
other use, even in part, is prohibited and requires our prior written permission. 
 
 

Publisher and copying rights: 

Opto France 
215, rue Noé et Célie Poncet 
ZA de Fontgrave 
F- 26740 Montboucher-sur-Jabron 
FRANCE 
 
Phone:     +33 4 75 53 14 00 
Email:      info@opto-france.com  
 
 

Technical Changes: 

We reserve the right to change our products and their specifications to the extent that the technical 
progress at any time. This also applies to the associated information in the current operating 
instructions. 
 

Trademarks: 

The terms and names used in this document are registered trademarks and/or products of the relevant 
companies. 
 
Copyright © 2021 Opto France 
All rights reserved 
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2 Document History 
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4 Introduction 

OptoViewer is the software companion of your Imaging Module. It enables quick setup, image 
acquisition, display and recording as well as measurements capabilities.  
 
If you want to integrate the Imaging Module into your own software environment - then the Opto-SDK 
is the perfect match for you. Please contact support@opto.de for this. 
 
Plug in and get started - we wish you a smooth and successful operation. 
 

5 Service 

Our technical staff is at your disposal by telephone or email in the event of faults or questions regarding 
compatibility, installation or maintenance. 
 

 
 

IMPORTANT INFORMATION 

All interventions on mechanical or optical parts inside the system as well as work on the 
device electronics of the Imaging Modules may only be carried out by the service 
department of Opto France or by specially authorized specialist personnel! 

 
 
Info service can be found under: 
 

Opto France 
215, rue Noé et Célie Poncet 
ZA de Fontgrave 
F- 26740 Montboucher-sur-Jabron 
FRANCE 
 

Phone: +33 4 75 53 14 00 
Email: support@opto.de 
 

 
 

6 Notes on this Manual 

The OptoViewer 2.0 application is intended to be used with Opto Imaging Modules. Before connecting 
an Imaging Module, we strongly recommend reading the Imaging Module user manual (see chapter 12). 
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7 Installation Guide 

1. Start Installer & Select Directory 
o Start OptoViewer software installer 
o Select target directory 

 
o Continue installation with the ‘Next>’ button 

 
2. Select Components 

o Select the required ‘OptoViewer’ components. 

 
o Continue installation with the ‘Next>’ button 
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3. Accept License Agreement 
o Confirm the licence agreements with a check mark. 

 
o Continue installation with the ‘Next>’ button 

 
 
 
 

4. Assign Shortcut Name 
o Assign shortcut name for Windows start menu (default: ‘Opto’). 

 
o Continue installation with the ‘Next>’ button 
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5. Start Installation 

 

IMPORTANT INFORMATION 
The installation can take a few minutes, as the program automatically 
detects and installs all necessary drivers and software components 

 

o Start installation with ‘Install’ button. 

 
o Continue installation with the ‘Next>’ button 

 
6. Complete Installation 

o Complete installation with ‘Finish’ button. 

 
o Software installation is completed. 

 
 

 
 

IMPORTANT INFORMATION 

For technical support, please contact support@opto.de. 
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8 User Interface 

8.1 General layout 

The OptoViewer user interface design is based on 3 main object types: 
 

 
Figure 1: OptoViewer 2.0 · General User Interface 

 

1 Menus to access features and options 

2 Toolbars to enable features or make actions 

3 Panels that enable to setup features or monitor 

4 Image displays 

 

  

1 3 4 
2 
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8.2 Menus 

Menus are mostly used to load and save files, display toolbars, setup preferences and access online 
help. The 5 available menus are detailed below. 

8.2.1 Menu · File 

 
Figure 2: Menu · File 

 

Item Description 

New Project Generates a new project. Refer to 8.6.2 for details. 

Load Project Loads an existing project. Refer to 8.6.2 for details. 

Save Project Saves a project. Refer to 8.6.2 for details. 

Save Image 
Saves the current selected image with template defined naming. Refer to 9.40 
for details. 

Save Image As 
Saves the current selected image. A dialog window opens to select file name, 
format and options. 

Exit Exits OptoViewer (user confirmation is requested). 

 

8.2.2 Menu · View 

 
Figure 3: Menu · View 

 

Item Description 

Cameras Displays/hides cameras image displays. 

Toolbars Displays/hides toolbars. 
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8.2.3 Menu · Tools 

 
Figure 4: Menu · Tools 

Item Description 

Devices Displays/hides the Devices configuration panel. Refer to 9.1 for details. 

Attributes Displays/hides the device Attributes panel. Refer to 9.3 for details. 

Light Displays/hides the Light control panel. Refer to 9.2 for details. 

Saving Displays/hides the Saving options panel. Refer to 9.4 for details. 

Magnifying Glass Displays/hides the Magnifying Glass tool. Refer to 10.3 for details. 

Histogram Displays/hides the Histogram graph. Refer to 10.1 for details. 

Horizontal Profile Displays/hides the Horizontal line Profile graph. Refer to 10.2 for details. 

Vertical Profile Displays/hides the Vertical line Profile graph. Refer to 10.2 for details. 

Overlays Displays/hides the Overlays configuration panel. Refer to 9.5 for details. 

Log Displays/hides the event Log view. Refer to 10.4 for details. 

Plugins Displays/hides the Plugins panel. Refer to 9.6 for details. 

 

 
 

IMPORTANT INFORMATION 
Items in the Tools menu behave like 2-state buttons: 

• Checked item means the associated feature/panel is visible. 

• Unchecked item (greyed icon background) means the associated feature/panel 

is not displayed. 

 
Figure 5: Menu · Tools - Status & Panels 
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8.2.4 Menu · Options 

 
 

 
Figure 6: Menu · Options 

 

Item Description 

OptoViewer Settings Opens the OptoViewer Settings window. Refer to 11 for more details. 

 
 
 

8.2.5 Menu · Help 

 
Figure 7: Menu · Help 

 

Item Description 

Online Help Opens the OptoViewer user manual. 

About… Software version and company information. 
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8.3 Toolbars 

Most OptoViewer tools can be quickly accessed with toolbars: 

 
Figure 8: OptoViewer 2.0 · Toolbars 

There are 3 toolbars that can be displayed or hidden using the View/Toolbars menu: 
 

• Operate toolbar for connecting to devices and controlling image streams 

• File toolbar provides same items as the File menu (8.2.1) 

• Tools toolbar gives access to most features and settings of OptoViewer 

8.3.1 Toolbar · Operate 

 
Figure 9: Toolbar · Operate 

Item Description 

 Opens/Closes Module: Releases access to selected module settings and features. 

 
Starts selected camera’s image stream. The module has to be opened first. 

 
Stops selected camera’s image stream. 

 Saves an image to file using a template naming. Refer to 9.4 for details about 
automatic naming setup. 

 Starts/stops image sequence recording. Refer to 9.4 for details about sequence 
recording setup. 

 
Pauses the recording process. 

 
Refresh the devices list. 
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Figure 10: Opening an Imaging Module 

 
 
To control a module, meaning setting it up and acquire images from its camera(s), you must first open 
it: 
 

1. The module must be listed in the Device panel list. If it doesn’t, right-click in the panel and select 

Refresh. OptoViewer will start the module detection process and update the device list to show 

all detected modules. 

 

2. Click on the needed module, then press the Open/Close Module button. This button should 

change state from  (module is closed) to  (module is opened). 

Once the module is opened, the other Operate toolbar’s button will be accessible. 

 
3. After opening a module, it becomes possible to start/stop a camera live stream and recording. 

 
 

  

Devices detection 

Device Connection 

Camera Start 

or 
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8.3.2 Toolbar · File 

 

Figure 11: Toolbar · File 

Item Description 

 Generates a new project. Refer to 8.6.2 for details. 

 Loads an existing project. Refer to 8.6.2 for details. 

 Saves a project. Refer to 8.6.2 for details. 

 
Saves the current selected image with template defined naming. Refer to 9.4 
for details. 

 
Saves the current selected image. A dialog window opens to select file name, 
format and options. 

8.3.3 Toolbar · Tools 

 
Figure 12: Toolbar · Tools 

Item Description 

 Displays/hides the Devices configuration panel. Refer to 9.1 for details. 

 Displays/hides the device Attributes panel. Refer to 0 for details. 

 Displays/hides the Light control panel. Refer to 9.2 for details. 

 Displays/hides the Saving options panel. Refer to 9.4 for details. 

 Displays/hides the Magnifying Glass tool. Refer to 10.3 for details. 

 Displays/hides the Histogram graph. Refer to 10.1 for details. 

 Displays/hides the Horizontal line Profile graph. Refer to 010.2 for details. 

 Displays/hides the Vertical line Profile graph. Refer to 10.2 for details. 

 Displays/hides the Overlays configuration panel. Refer to 9.5 for details. 

 Displays/hides the event Log view. Refer to 10.4 for details. 

 Displays/hides the Plugins panel. Refer to 9.6 for details. 
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8.4 Panels management · Docking, Stacking, etc. 

The OptoViewer allows a very flexible user interface management, with the ability to position panels in 
many ways. A panel can be set in a fixed position (“docked”) or floating. Docked panels can also be 
stacked on top of each other. 
 

 
Figure 13: OptoViewer  2.0 · Panels positioning style 

In the illustration above: 
 

1 The Devices panel is docked (fixed position) in the top right. 

2 The Histogram panel is floating. 

3 Attributes and Light panels are stacked. 

 

 

To change a panel’s position: 
 

1. Click on the panel’s title bar. The title bar becomes dark blue. 

2. Drag the panel to change its position. 

3. Depending on the context, many possibilities will be shown to drop it. 

Below are some examples. 

1 
2 

3 
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Figure 14: Stacking panels 

 

 Drop the panel. Histogram and Devices panels are stacked 

 Histogram panel’s initial position 

 Drag histogram to devices 
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Figure 15: Placing Panels relatively to each other 

 Dragging Histogram above Devices panel: positioning icons appear 

 Dragging ‘on panel’s top’  icon shows destination as a blue zone 

 Once dropped, the Histogram’s panel is placed on top of the Devices one 
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Figure 16: Docking panels on top  

 Dragging Histogram above Devices panel: positioning icons appear 

 Dragging ‘on top’ icon shows destination as a blue zone 

 Once dropped, the Histogram’s panel is placed on top of the layout 
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8.5 Images Displays & Status Bar 

8.5.1 Presentation 

An image display automatically appears for every camera that is started. It’s made of a display area, a 
display name and a status bar. 

 
Figure 17: OptoViewer 2.0 · Image Display 

1 Display name 

2 Display area 

3 Status bar 

 
The display name shows the module name followed by the camera name. In the example above, the 
displayed image comes from the camera named Camera which belongs to the Simulation Module. 
The display area contains the image. Zoom in and out is possible by using the mouse wheel. When the 
image is bigger than the display area, scrollbars appear. 
 
The status bar shows the following information: 
 

• On the left side: 

o The image size in pixel (in the example above: 2456 pixels x 2054 pixels). 

o The value of the image pixel the mouse cursor is on as well as the pixel depth (in the 

example above the pixel has a value of 65, coded on 8bit -> the image is monochrome 

8 bits). 

o The coordinates (in pixels) of the image pixel the mouse cursor is on (in the example 

above x=17, y=2031). 

• On the right side: 

o The zoom factor (in the example above 0.40x). 

A zoom ratio of 1 means 1 image pixel fits 1 display (monitor) pixel. 

A zoom ratio higher than 1 means 1 image pixel is represented by more than 1 display 

pixel -> the image display is zoomed in (magnified). 

A zoom ratio smaller than 1 means 1 image pixel is represented by less than 1 display 

pixel -> the image display is zoomed out. 

1 

2 

3 
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o The image index: this value is incremented every time an image is captured. During a 

continuous acquisition, this value should be incrementing. 

8.5.2 Full Screen Feature 

It is possible at any time to display an image in full screen mode. This is a useful feature: 
 

• to take advantage of the full monitor space, 

• when multiple images are displayed in the same time. 

 

8.5.2.1 Activating Full Screen 

 

Figure 18: Enabling Full Screen 

1. Right click in the display area showing the image you would like to display in full screen: a 

context menu appears listing available monitors. 

2. Select the monitor on which to display the image in full screen: the image is displayed on the 

selected monitor while still being displayed in the OptoViewer main user interface. 

 

 
 

IMPORTANT INFORMATION 
Zooming is possible in a full screen view by using the mouse wheel. 
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8.5.2.2 Removing Full Screen 

There are 2 ways to remove a full screen display: 
 

1. Click in the full screen display to remove and press the Escape (Esc) key. 

2. In the OptoViewer main interface, right-click in the image that is also displayed in full screen: 

the context menu appears. Select Exit FullScreen Monitor… 

 

Figure 19: Exit Full Screen option 

 
 

8.6 Layouts & Projects 

Layouts and Projects are features that enable the customization of their Opto system to optimize the 
user experience: 

• Layouts are presets of OptoViewer user interface. It includes which elements (panels, 

toolbars, etc.) are opened, how they are positioned and sized. 

• Projects are entire definition of an OptoViewer setup including: 

o Layout settings 

o Hardware Modules settings and states (closed or running) 

o Applied processing (Overlays and Plugins) 

 

8.6.1 Layouts 

A Layout defines which elements (panels, toolbars, …) are opened, how they are positioned and sized. 
The needs for a good user experience depend on the application or domain as well as the user tasks. 
Depending on these factors, the tools available on the screen as well as the organization in the 
application window can strongly vary. 
 

 
Figure 20: Basic Layout vs. Advanced Layout 

It is possible to define custom layouts as presets that can be applied at any time. For more details on 
how to save or select a layout, refer to 11.1. 
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8.6.2 Projects 

Whereas a Layout is about the user interface, the Project defines the whole OptoViewer system 
configuration. It includes the interface Layout, the modules settings, the Overlays on the displayed 
images and the Plugin sequences applied also to the images. 
 

 
Figure 21: Project considered Specifications 

 
Projects can be saved in ovp files using the File\Save Project... menu. This will save the whole current 
configuration being used: 
 

Layout If a layout preset has been selected (see Layouts), this preset will be applied 

when the project is loaded. 

Modules Settings E.g. frame rate of the camera or illumination type and brightness. 

Overlays Includes Basic and Annotation tools. 

Plugins Whole sequences are considered. 

 
You can load a previously saved Project using the File/Load Project... menu. It is possible to setup 
OptoViewer to load a specific Project at start up. Refer to 11.2 for more details. 

  

 Layout 
Preset 

Modules 
Settings 

Overlays 
Settings 

Plugins 
Sequence 

PROJECT 
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9 Control Options 

9.1 Panel · Devices 

The Devices panel lists all connected imaging modules (and their cameras) which can be physical devices 
or simulated ones. Refer to 8.3.1, for more information on how to open a module and start using it. 
When a module is selected all control panels (Attributes, Light, …) will apply to that selected module. 

9.1.1 Camera Settings 

For every camera, it is possible to configure its specific Acquisition and sequence recording parameters. 
Camera settings are for advanced users. Default parameters will fit most applications. 
 

 
Figure 22: Panel · Camera Settings 

Item Description 

Buffers Count Number of buffers allowed to store images in case of computer latencies. 

Buffer Mode Sets which image to grab from the available buffers: 

• Next: available buffers are not considered, instead OptoViewer will wait 
for the next image coming from the camera. 

• Last: OptoViewer will get the last acquired buffer even if this buffer has 
already been used previously. 

• Last new: OptoViewer will get the last acquired buffer if it has not been 
used yet, otherwise it will wait for the next buffer to come. 

• Oldest: OptoViewer will get the oldest unused buffer. 

Timeout Maximum duration to wait for an image. If the timeout is reached, the software 
stops the acquisition. 

Startup Action Defines the behaviour of the camera when the module is started: 

• None: camera is not started. 

• Start Acquisition: the camera is started and images are displayed. 

• Start Acquisition and Recording: the camera is started, images are 
displayed and recorded (based on configuration in the Saving panel). 
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9.1.2 Simulation Modules 

It is possible to define Simulation Modules which will generate an image stream based on image files. 
Definition of simulation modules can be set in the OptoViewer Settings window (refer to 11.3 for more 
details). The following attributes can be set up in the Attributes panel of a simulated module: 
 

 

Figure 23: Simulation Module Attributes 

Item Description 

Path File path of an image that will be displayed. Depending on the state of the Cycle 

attribute, only this image will be used or all images on the same folder with the same 

image size and type (monochrome, colour). 

Cycle When Cycle is disabled, only the image file which path is defined in Path attribute will 

be used. When enabled, the image stream will cycle between all images in the same 

folder that have the same image size and type (monochrome, colour) as the one 

selected in Path. 

Acquisition Defines the refresh rate of the simulated image stream. 
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9.2 Panel · Light 

The Light control panel controls lighting type, power and camera exposure time. It is displayed by 
enabling Light on tools toolbar or by selecting Light in Tools menu.  

 
Figure 24: Opening Light panel 

 
When the selected module is opened, a panel is displayed with three sections: 
 

 
Figure 25: Panel · Light 

1 Save button 

2 Light management 

3 Exposure Management 

 
 

 
 

IMPORTANT INFORMATION 
The light panel control is disabled and greyed out when: 

• no module is selected, 

• the selected module is not opened, 

• the selected module has no light implemented. 
 
These features will be described in below chapters. 
 
  

1 

2 
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9.2.1 Save Button 

The Save button saves light and exposure attributes, but also all module attributes listed in attributes 
panel. A confirmation is requested when using it. 

 
Figure 26:  

Attributes saving warning message 

 

9.2.2 Light Management 

To manage the light, it is possible: 
 

• to choose the type of light (ring, coaxial, etc. - depending on the module type), 

• to adjust the power. 

 
 

9.2.3 Exposure Management 

An Auto Exposure can be activated with function On, so the exposure time is automatically adjusted. Be 
aware that no automatic gain is applied, only exposure time is controlled. When a low frame rate is set, 
this allows long exposure times to be applied in case of low light conditions. Long exposure time can 
cause motion blur in case of moving object. It is always recommended to increase the light power if 
possible. If it is set to Off, the exposure time can be manually adjusted. 
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9.3 Panel · Attributes 

The Attributes panel displays the parameters of the module you have selected in the modules’ list. It 
allows module attributes management and settings. This panel offers further settings in terms of 
module control.  
It is displayed by enabling Attributes on tools toolbar or by selecting Attributes in Tools menu.  

 
Figure 27: Opening Attributes panel 

 
This panel displays attributes, ONLY for the selected and opened module. Attributes are organized in a 
tree structure. If the selected module is opened, a panel is displayed with three zones: 
 

 
Figure 28: Panel · Attributes 

 

1 Attributes management 

2 Attribute tree 

3 Attribute information 
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2 
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IMPORTANT INFORMATION 
If no module is selected or if the selected module is not opened, the following message 

will be displayed: 

 
 

 
 
 

9.3.1 Attributes Management 

 

 Sets visibility (default Simple). 

 Saves attributes. 

 Refreshes attributes. 

 Displays Favourites. 

 Searches for attributes according to 
the filter input. 

 
 

Deletes filter. 

 
 
 

9.3.1.1 Visibility 

Changing the Visibility value will update the attributes tree. Visibility can be set to Simple, Intermediate, 
All or Favourites.  
 

• Simple, Intermediate and All respectively display a minimum, intermediate and maximum 

number of attributes in the tree. 

 

• Favourites displays attributes as configured with button . 
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Figure 29: Examples of attributes visibility 

 

9.3.1.2 Save Attributes 

Attributes values can be modified directly in the tree (refer to Attributes Tree for details). These values 
can then be saved. Next time the module will be opened, the saved attributes values will be loaded. 
 

9.3.1.3 Refresh Attributes  

Some attributes are linked with each other. That means changing values could automatically have an 
influence on other parameters. For example, when Exposure Auto is checked, Exposure Time will be 
automatically adjusted. Press button Refresh to see updated value. 
 

 
Figure 30: Example of relationship between Exposure & Frame Rate 

 
  

Visibility Simple Visibility All 

Before After  Refresh 
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9.3.1.4 Favourites 

While dozens of attributes are available for a module, most users usually only need a very limited 
number (sometimes only 1 or 2). OptoViewer offers the possibility to define your own favourites, which 
represent a user-specific group of attributes. 
 
Setting and using Favourites is a 2 steps process: 
 

1. Click on Favourites button  

A dialog box appears, allowing to select which attributes to set as favourites. 

 

2. Set the Visibility to Favourites 

Only attributes previously selected as Favourites will be listed in the tree, making them very 

easy and quick to access. 

 
Figure 31: Using favourites feature 

 

9.3.1.5 Search Attributes 

Input a text in this field to see only filter attributes which name contains the input text. By clicking on 
Delete filter button, the search is cleared.  
 
 

 
Figure 32: Example of attributes filter 
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9.3.2 Attributes Tree 

The attributes tree displays the attributes of the selected module and their values. By clicking on the 
arrows, it is possible to expand or collapse the branches of the tree. 
 

 
Figure 33: Attributes tree 

Some attributes are read-only. They are disabled and greyed out. Others can be modified by selecting a 
value in a combo-box, clicking on the increment/decrement buttons or typing the value on keyboard. 
When a value is selected, detailed information is displayed in the Attribute Information control. 
 

 
 

IMPORTANT INFORMATION 
Some attributes can only be set when the image acquisition is stopped (for example image 
width, height, …). 

 

9.3.3 Attributes Information 

The details displayed in the information section are at least the description. If the selected attribute has 
a numeric value, there are also units, range and step. The step is the value added/substracted by 
increment/decrement button. 
 

 
Figure 34: Attribute Information  
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9.4 Panel · Saving 

9.4.1 Configuring Saving Sequences & Single Images 

By default, records are saved in the ‘Pictures’ folder on the computer, as PNG images. The memory 
options are displayed by enabling Saving on Tools toolbar or by selecting Saving in Tools menu.  

 
 This will open the Saving Panel which is divided into 2 sections:  
 

1. Sequence is used for continuous recordings and can either save images in a folder 
or as a video file.  

2. Snapshot is used for automatic saving of single shot images. 
 

 
Figure 36: Saving taps 

 

Figure 35: Opening Saving panel 
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The available memory options are described in below table: 
 

Item Description 

Recording Mode Images (in a folder) or Video. Only available in Sequence tap. 

File Path Template Selects where the record or image is saved and named. The button on the 
right open the File Path template editor, allowing to select standard path 
on the computer (pictures, documents, etc.) or custom path, and append 
various tag to the record name: date, timestamp, frame index, etc. Refer 
to 9.4.2 for details. 

File Format List depends on saving mode. For images, options are png, bmp, tif, jpeg 
and jpeg 2000. For video, options are avi, mp4 and mkv. 

File Compression Each file format has a specific set of compression parameter. See section 
File Path Template Editor for details. 

Merge Overlays This check box allows to merge Overlays defined into the image. 

Record Image Every… This check box allows you to record images at a limited frequency, to 
reduce data size. It also known as ‘Time lapse recording’. 

 

9.4.2 File Path Template Editor 

The File Path Template editor is used for auto naming the record. You can mix custom text and system 
tag to create the desired file name and save folder. 
To add custom text, type in the text zone. You can add or remove “/” to change directory structure. 
Folders are automatically created when record start. To add tag, double click the tag in the list. 
 
 

 

 
 
 
 
Example:  
PNG 
F:/OptoViewerRecord/[date]_[time]/MY_EXPERIMENT_[frameindex] 
=> 
F:\OptoViewerRecord\08-26-2021_16-43-
48\MY_EXPERIMENT_0000021689.png 
 
AVI 
[documents]/OptoViewer/[date]/[time] 
=> 
C:\Users\Office Manager\Documents\OptoViewer\08-26-2021\16-
46-40.avi 
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9.5 Panel · Overlays 

Overlays are visual interactive options that are embedded to the camera display window that can display 
and draw shapes and compute measurements. 
 

9.5.1 Accessing Overlays Panel 

The Overlays panel is displayed by enabling Overlays on tools toolbar or by selecting Overlays in Tools 
menu. 
 

 
Figure 37: Opening overlays panel 

 
 

 
Figure 38: Panel · Overlays 

 
Overlay tools are split in 2 tabs: 
 

1 Basics: includes basic overlays useful for module setups  or documentation purposes. 

2 Annotations: includes further documentation or analysis tools. 

 
 
 
  

1 
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9.5.2 Basic Overlays 

The Basic overlays as their name suggests, are overlays that are commonly used for several purposes 
e.g. module setup. 
 

• Crosshair: 

  
 
 
 
 

Displays a crosshair at the desired position, 
with a custom width and colour. 

 

• Toggle Visible to display it on the 
window. 

 

 

 
Figure 39: Overlay · Crosshair 

• Grid :  

  
 
 
 
 

Displays a grid with a desired spacing, width 
and colour. 
 

• Toggle Visible to display it on the 
window. 

 

 

 

Figure 40: Overlay · Grid 



OptoViewer 2.0 
Opto Software 
  
User Manual 

 
       www.opto.de 

Date: 2022-01-17 Author: SF Release: JCB  Usage: internal / external Page: 38 / 65 

                   O p t o  F r a n c e  –  2 1 5 ,  r u e  N o é  e t  C é l i e  P o n c e t  -  F - 2 6 7 4 0  M o n t b b o u c h e r  s u r  J a b r o n  -  T e l .  + 3 3  4  7 5  5 3  1 4  0 0  -  w w w . o p t o . d e  

 

• Scale : 

 
 

 
 
 
 
 Displays a custom scale at the desired position 

(Bottom-Right, etc.) with a desired width, 
precision and colour.  
It can either be defined in pixels or mm  
(requires a calibrated module). 
 

• Toggle Visible to display it on the 
window. 

 

 

 
Figure 41: Overlay · Scale 
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• TimeStamp :  

 
 

 
 
 
 
 

Displays a timestamp at the desired position, 
with a custom colour, as well as which clock to 
use ( start of acquisition, start of recording or 
system clock ) 
 

• Toggle Visible to display it on the 
window 

 

 

 
Figure 42: Timestamp overlay 

 
 
 

 
 

IMPORTANT INFORMATION 
You can only have ONE instance of every type of Basic overlays, Annotations (9.5.3) are 
different and can be stacked. 
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9.5.3 Annotations 

The Annotations are a tool set dedicated to add certain objects in the image or FoV. These overlays can 
be adjusted to either add visuals (e.g. Text, Images, Lines, Rectangles) or to compute certain features 
such as angles, lengths or areas. 
 

 
Figure 43: Tab · Annotations 

Button Description 

 Default, a cursor used to select tabs, displays, menu, etc. 

 Draws a line on the display window. 

 Draws a rectangle on the display window. 

 Draws a circle from 3 points. 

 Draws an ellipse. 

 Inserts an image. 

 Inserts text. 

 Computes the length of a drawn segment (in pixels or mm if a calibration is 
used). 

 Computes an angle from 3 drawn points. 

 Draws a Polygon, double clicking closes the polygon. 

 

Contours an area by clicking on an ‘object’: all pixels around the clicked one 
that have the same value (+/- tolerance) will define a selected region which 
perimeter and area are computed. 
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IMPORTANT INFORMATION 
Annotations can be stacked, and as such you can have multiple instances of the same tool 
present at the same time. 

 

 
Figure 44: Examples of annotation tools 

 
  

 Using Contour Area by clicking on the ‘t’ in the Opto Logo,  we can also choose a level of tolerance. 

 Drawing a Rectangle 
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9.5.4 Managing Annotations 

As described previously, annotations can be stacked, they can also be managed, renamed and deleted. 
 

 
Figure 45: Annotation Management 

Button Description 

 Lists annotations. 

 Renames annotation. 

 Re-orders list of annotations. 

 Deletes an annotation. 

 Deletes all annotations. 
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9.6 Panel · Plugins 

9.6.1 Introduction 

Plugins are additional tools that can be applied to image streams. Most of them are image analysis tools, 
used to get data from the images or processing tools used to transform or enhance images. 
 
The Plugins panel is displayed by enabling Plugins on tools toolbar or by selecting Plugins in Tools menu. 

 
Figure 46: Opening Plugins panel 

This will open the Plugins panel in the attributes window as shown below:  

 
Figure 47: Panel · Plugin 

Button Description 

 Adds a new Plugin step. 

 Deletes/removes a step. 

 Step setup. 

 Renames a step/plugin. 

 
 

Re-orders plugins (Plugins are applied according to this order). 

 

 
 

IMPORTANT INFORMATION 
Camera/module must be initialized for running Plugins. 
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9.6.2 Using Plugins 

 
1. Click on the Add New Step        button.  

The following window opens, listing available plugins: 

 

 

Figure 48: Plugins · Add Step 

 

2. Select a Plugin from the list and press Ok. 

An instance of the selected Plugin (called a step) is added to the sequence and the plugin’s 

settings window opens.  

 

 

Figure 49: Plugins · Sequence Overview 

3. Configure the step and press Ok. 

The step is added to the end of the sequence. 

 

4. To edit the configuration of a step:  1st Select the step in the sequence list 

2nd Press the Plugin settings button   

 

 
 

IMPORTANT INFORMATION 
The sequence is applied from top to down: the step on top is executed first, then the one 
below and so on. 
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9.6.3 Standard Plugins Configuration 

Some Plugins are included by default when OptoViewer is installed. These includes: 
 

• Geometric Transform 

• Vignetting Correction 

• Measure Focus 

These are described in more detail in the following chapters. 

 

9.6.3.1 Geometric Transform 

This Plugin enables to flip, rotate or resize an image. Most used are Symmetry and Rotation to 
compensate for instance an Imaging Module mounting on a stand that does not match the operator’s 
point of view. 
One Geometric Transform step applies only one transformation. If you need to combine multiple 
transformations (for instance Symmetry plus Rotation), you must insert multiple steps using the 
Geometric Transform Plugin. 
 
To setup a Transformation following steps have to be carried out: 
 

1. Select needed transformation in section Transform Mode. 
2. Set desired parameters in workspace Settings below. 

 
 

 
Figure 50: Plugin · Geometric Transformation -  Setup Panel 
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Transformation specific settings are then straightforward: 

 
Figure 51: Transformation specific settings accord. to selected Transformation Mode 

 
 
 

 
  

 

IMPORTANT INFORMATION 
In Rotation Settings the Maintain Image Size parameter can be disabled to get images that 
are optimized for the transformation applied.  

• With this setting disabled, a rotation of 90° applied to a 1024 pixels x 768 pixels  
image, will output a 768 pixels x1024 pixels image. 
When Maintain Image Size is enabled, the output image will remain 1024 pixels x 768 
pixels, resulting in clipping at the top and bottom and black bars at the left and right 
of the image. 

 

 
Figure 52: Maintain Image Size effect 

Original image 

Maintain Image Size disabled 

Maintain Image Size enabled 
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9.6.3.2 Vignetting Correction 

Vignetting Correction allows to compensate for brightness non uniformity due to optical limitations or 
illumination issues for instance. 
 
There are 2 methods for defining a correction: 

 

• Based on ‘Reference Images’ 

• Based on a ‘Polynomial Model’ of the vignetting 

 

 
Figure 53: Plugin · Vignetting Correction - Setup Panel 

 
 

1 Quick Display to see how the processes affect the displayed image. 

2 Defines which image to display on the Quick Display (1). 

3 Defines White Reference Image settings. 

4 Defines Black Reference Image settings. 

 
  

2 

3 

4 

1 
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The available methods for handling the White Reference Image are: 
 

 
Figure 54: Vignetting Correction · Available methods 

 

Method Description 

Load Image from File Loads the White/Black Reference image from a defined folder. 

Use Average Image Uses images of a ‘white’ surface to compute an average, and 
correct the acquired images. 

Use Background Model Image Uses image of a ‘white’ surface to compute a polynomial model 
that corrects the image. 

 
In the following images you can see an example correction, calculated with a 2nd degree polynomial 
model. The corners of the input image are darker than the centre. After the correction is applied, overall 
brightness is uniform. 
 

 
Figure 56: Vignetting · 2nd degree correction 

 
  

           Original bright image          Corrected image 

Figure 55: Model based correction example 
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9.6.3.3 Measure Focus 

The Measure Focus Plugin computes a focus indicator in a rectangular area. The higher the value, the 
sharper the image (in the region defined by the rectangle). 

 
Figure 57: Plugin · Measure Focus - Setup Panel 

You can view the overlay of the Measure Focus process in the main display: 

 
Figure 58: Live Focus Measurement 

 IMPORTANT INFORMATION 
Don’t forget to toggle Enabled for the plugin steps to be applied. 
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10 Analysis features 

10.1 Histogram 

This Histogram panel graphically displays quantitative distribution of the colour values within the image 
captured by the camera. It is useful to evaluate the quality of images by providing general information 
on brightness, contrast and saturation. 
It is displayed by enabling Histogram on tools toolbar or by selecting Histogram in Tools menu.  
 

 
Figure 59: Opening Histogram panel 

 
Figure 60: Histogram · Colour image 

You can get a general idea of the brightness of an image by looking at the Histogram and observing the 
spatial distribution of the values. If the histogram values are concentrated toward the left, the image is 
darker. If they are concentrated toward the right, the image is lighter. 
 

 
Figure 61: Under-exposed image 
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Figure 62: Over-exposed image 

A histogram in which the pixel numbers evenly cover a wide range of grey levels indicates an image with 
good contrast. Pixel numbers that are limited to a smaller range indicate low contrast. 
 

 
Figure 63: Well exposed image 

A histogram with a prominent spike at the highest possible pixel value 255 (visible in over-exposed image 
above) indicates that the image’s pixel intensities have experienced saturation. 
 
The histogram of a colour image indicates the quantitative distribution of its pixels per colour 
components. It provides a general description of the appearance of an image and helps identify its 
various components. 
 

 
Figure 64: Colour image with associated Histogram 
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The following options are available: 
 

Item Description 

 Selects the camera to be displayed. 

 Refreshes the display. 

 Selects RGB, Red, Green or Blue channel (default value RGB). 

 Displays only the profile if checked, or full coloured curve if not 
checked. 

 
 

Displays the minimum, maximum, mean and standard deviation of 
the distribution. If RGB channel is selected, three values are 
displayed, one for each channel. 

 
 

 
Figure 65: Histogram · Profile option on RGB 

 

 
Figure 66: Histogram · Profile option on single channel 

  

Channel: RGB · Profile checked 
Channel: RGB  · Profile unchecked 

Channel: Red · Profile unchecked Channel : Red · Profile checked 
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10.2 Horizontal & Vertical Profiles 

The Horizontal/Vertical Profile panels shows the colour value of pixel row/column. 
It is displayed by enabling Horizontal/Vertical Profile on tools toolbar or by selecting Horizontal/Vertical 
Profile in Tools menu.  
 

 
Figure 67: Opening Profiles panels 

By default, the pixel row/column is placed in the centre of the image. It can be adjusted by clicking on 
the image or by entering a value in the Row/Column control.  
 

 
 
 

Horizontal Line 

Horizontal Profile Panel 

Figure 68: Panel · Horizontal Profile 
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Figure 69: Panel · Vertical Profile 

 
The following options are available: 
 

Item Description 

 Selects the camera to be display. 

 Refreshes the display and put the horizontal/vertical line in the 
centre. 

 Selects horizontal line tool (only Horizontal Profile). 

 
 

Selects vertical line tool (only Vertical Profile). 

 
 

Selects RGB, Red, Green or Blue channel (default value RGB). 

 Sets the pixel row to display (only Horizontal Profile). 

 Sets the pixel column to display (only on Vertical Profile). 

 

Displays the minimum, maximum, mean and standard 
deviation. If RGB channel is selected, three values are 
displayed, one for each channel. 

 
  

Vertical Line 

Vertical Profile Panel 
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The following image shows the distinctive profile lines of a barcode. 
 

 
Figure 70: Horizontal Profile · Barcode example 

 

 
Figure 71: Vertical Profile · Barcode example 

 

  

From left to right on the Horizontal Profile corresponds to from left to right on the horizontal line. The curve starts and ends with 
value 255 (white pixels). Each decreasing peak to 0 corresponds to a black line. 

From left to right on the Vertical Profile corresponds to from top to bottom on the vertical line. The curve starts with value 255 
(white pixels), then decreases to 0 corresponding to the black line and ends with value 255 (white pixels). 
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10.3 Magnifying Glass 

A Magnifying Glass creates a display window that follows the cursor around the display panel and zooms 
in on the ROI surrounding the cursor. 
 

 
Figure 72: Opening Magnifying Glass panel 

 
It is displayed by enabling Magnifying Glass on tools toolbar or by selecting Magnifying Glass in Tools 
menu.  
 

 
Figure 73: Panel · Magnifying Glass 

1 Display panel for zoomed image. 

2 Zoomed area in complete image area. 

 

  

1 

2 
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10.4 Log 

The Log management offers a deeper look at the application and what happens in the background of 
the OptoViewer. It can be used to monitor actions, errors and warnings. It is displayed by enabling Log 
on tools toolbar or by selecting Log in Tools menu.  
 

 
Figure 74: Opening Log panel 

 
 

 
Figure 75: Panel · Log 
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The Log is used to monitor OptoViewer - any errors or warnings will be displayed.  
 

 
Figure 76: Log · Controls 

1 Selects event types. 

2 Saves log analysis in a file. 

3 Clears listed log data. 

 
 
 

 
 

IMPORTANT INFORMATION 

• If there is an issue during recording or acquisition, the Opto SDK will return an 
error code in the Log that can be used to isolate the issue to image processing, 
memory issues, etc. Use the documentation for the SDK to find error descriptions. 

• Deleting a Log Level (Error, Warning, All, etc.) will only delete the selected level. 
 
  

1 

2 3 
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11 OptoViewer Settings 

To access OptoViewer application settings, use Options/OptoViewer Settings... menu. The settings 
window will be opened. The left side lists the different categories available whereas the right side shows 
the corresponding options. 

 
Figure 77: Panel · OptoViewer Settings 

11.1 User Interface 

The User Interface category shows the following options: 
 

Item Description 

Language Defines language that will be used in the user interface. Default is English. 

Theme Defines colour sets applied to the whole user interface. default theme is standard 

Windows 10 style. Dark theme is more suitable for low light environment. 

Layouts Enables the management of different user interface layouts. Refer to 8.6.1 for more 
details. 

 

 

Figure 78: OptoViewer Settings · Layout Options 

If Layouts have been previously saved, the combo box enables to one of those: 

Button Description 

 
Creates a new layout preset based on the currently used layout. A name is 

requested to identify a layout preset. 

 Updates the currently selected preset to the current layout. 

 
 

Deletes the currently selected preset. 

 
 

Deletes all presets. 
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11.2 Project 

A Project defines the whole OptoViewer system configuration. This includes the interface Layout, the 
modules settings, the Overlays on the displayed images and applied Plugins. 
 

 
Figure 79: OptoViewer Settings · Project category 

It is possible to automatically load a saved Project when starting OptoViewer. For more information on 
Projects, see 8.6.2. 
 

11.3 Modules 

 
Figure 80: OptoViewer Settings · Modules category 

It is possible to define Simulation Modules which integrates a virtual camera that can be setup to load 
image files instead of having a real image stream. It is possible to define more than 1 simulation module. 
After changing this option, restarting the software is required to get Simulation Modules to be listed in 
the Devices panel. 
 

 
 

IMPORTANT INFORMATION 
After restarting the software to detect a new Simulation Module, it requires some 
attributes to be set up properly to generate an image stream. Refer to 9.1.2 for more 
details. 
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11.4 Keyboard 

It is possible to associate keyboard shortcuts to actions on the active camera. These shortcuts will 
generate the same action as the dedicated buttons in the toolbar Operate. 
 
One common application of this feature is to use a pedal switch to start/stop image stream or record a 
sequence or an image. This is useful to trigger such actions while keeping hands free. Many pedal 
switches on the market works as keyboard key(s) emulators, making it easy to integrate. Some 
presentation pointers also work by emulating some keyboard keys and can be used for basic wireless 
control without the need for a keyboard or a mouse. For more information about such devices, do not 
hesitate to contact our technical support (support@opto.de). 
 

 
Figure 81: OptoViewer Settings · Keyboard category 

 
To define a shortcut to an action, carry out following step: 
 

• Click in Press shortcut, and press the key (for instance the ‘A’ key) or combination 
of keys (for instance ‘Ctrl’ + ‘A’ keys) you would like to associate to the action.  
 

To delete a shortcut, press the button  on the side. 
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11.5 Web Server 

11.5.1 Web Server Definition 

A web server is a background process running on a device or in a software application. A client 
application or process can connect to the server locally or through the network to communicate for 
control purpose or getting data from the server. It is very common in network connected devices like 
printing machines, WIFI extenders, etc. which you can configure remotely via HTTP protocol, usually 
implemented in Web pages. 
The same applies to OptoViewer when its integrated web server is enabled: the Web Server will allow 
remote control of the OptoViewer session (modules listing, configuration, starting, … and monitoring) 
either by connecting to the default webpage or by sending specific HTTP commands.  

11.5.2 Web Server Settings 

 

 
Figure 82: OptoViewer Settings · Web Server category 

 
 
To enable the Web Server feature, connection parameters must be set: 
 

Item Description 

Web Server IP address Sets which IP address the server should listen to. The field lists network 
connections/adapters available on the system.  
Default option, listed as 127.0.0.1 (Loopback Pseudo-Interface) is the one 
to choose when clients will be local (running on the same computer). 

Web Server Port Sets which port the server will listen to for client connection. In order to 
connect to the Web Server, client processes should target the IP address 
set above plus the port defined. 
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The next parameters are used to optimize the remote monitoring capabilities of the Web page: 
 

Item Description 

Web Page Refresh 
Frequency (ms) 

Defines the rate at which the Web page will refresh all monitoring 

information it provides. Default value is 500 ms. 

Web Page Image Quality 
Factor (%) 

Defines the quality or compression rate that is applied to the images 
displayed in the Web page. The higher this value, the better the image 
quality. The lower this value, the lower the bandwidth required for 
transmitting the data. Default value is 50%. 

Web Page Image Scale 
Factor (%) 

In order to reduce the bandwidth required to transmit images, set this 

parameter to rescale the images to a lower resolution. 100% means no 

scaling is applied. Default value is 50%. 

 

More generic options are available: 

Item Description 

Log Web Server Events When activated, Web Server related events will be listed in the Log 

panel. 

Launch Web Server At 
Startup 

When activated, the Web Server will be enabled when the 

OptoViewer starts up. 

 

Once all above options have been set, press Start Server button to start the Web Server process: 

• The Start Server button becomes disabled 

• The Stop Server Button becomes enabled 

• The Web Server Status should indicate Started 

If there are no such changes, it means the Web Server was not able to start properly. Try another port 
and/or IP address. We also recommend you check with IT department if there are restrictions applied 
on your local network on some addresses, ports or network services. 
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11.5.3 Default Web Page 

The bottom of the Web Server options form contains 2 URL links: 
 

• The first (Homepage) is the URL of the OptoViewer Web Server homepage. This homepage can 

be opened from any Web browser and gives access to many features of the modules : listing 

devices, setting attributes, starting streams and records and of course getting image display.  

 

Figure 83: OptoViewer Settingd· Homepage 

• The second URL opens a Web page listing all commands that can be used to communicate 

with the Web Server. These commands can be integrated in a custom application, that will 

control OptoViewer. 

 
Figure 84: Web Server commands Web page 
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12 Additional Documentation 

For further technical tips on hardware and software, we recommend that you consult the latest version 
of the associated documentation. 
 

IM ● Hardware & Software Documentation 

IM · Standard Series Quick Start Guide(s) https://www.opto.de/en/company/downloads/ 

IM · USB interface Application Note https://www.opto.de/en/company/downloads/ 

Imaging Modules 
linea S, M · compact M · profile M 

User Manual https://www.opto.de/en/company/downloads/ 

Opto · OptoViewer 2.0 Quick Start Guide support@opto.de 

Opto · SDK User Manual support@opto.de 

 
For further assistance please contact support@opto.de. 
 


